)

triamec

TAM System Explorer

Release Notes

This document describes the evolution of the TAM System Explorer application as a log of notable
changes.

Software Modules

There is a similar document, the TAM API release notes [1], which is more focused on the modularized
software libraries of the TAM Software. Since most of the changes to the TAM System Explorer do also
affect the API, these release notes are split into different modules for the developer’s convenience, too:

Triamec.Tam.UI contains user interfaces.
Triamec.Tam.Core provides most of the APIs.

Triamec.Tam.Trialink and Triamec.Tam.EtherCat allow for access to Tria-Link and EtherCAT devices, re-
spectively.

Triamec.Common supplies shared functionality around settings and logging.
Triamec.Tam.Simulation supports offline analysis of system properties.

Sometimes, a regression is described using a reference to the breaking release. That version is a module
version if not otherwise noted.
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TAM Software 7.29.0

Introduces the Setup Assistant.
Release date: 2025-07-23
New

= Assistant > Setup Assistant. Open the Setup Assistant from within the TAM System Explorer. The
SetupAssistant can also be opened via the Windows start menu.

’ Setup Assistant

Welcome to the Drive Setup Assistant

This assistant supports setting up a configuration for Triamec TSD and TSP servo
drives. You can start the assistant by loading an existing configuration from a
connected drive, from a .TAMcfg file, or start a configuration from scratch. After
every completed step and at the end of the assistant, you can save your
progress as a configuration file.

 Drives Found W Assistant ready
Please select your mode of configuration: O Configuration
" @ Initialization
© Motor
O from drive Triamec-616 @ Path Planner
© Encoder
AN J
h © Position Controller
s © Commutation
© Current Controller
J
e
O new configuration
Triamec.Tam.Ul 8.4.0
Bugs
= Scope plot cursors get removed if they move out of the displayed range while recording in rolling
mode.

= Disabled Zoom Arrange by pressing F6 during active recording to prevent crashes.

Triamec.Tam.TriaLink 7.24.0

New
= Introduces a "Remote Devices" field to Preferences. Drives specified in this list can now be discov-
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ered and connected to by the System Explorer, even if they are outside the local subnet.

TAM Software 7.28.2
Supports the new AngleSearch2 phasing method.
Release date: 7.5.2025

Triamec.Tam.Ul 8.3.1

Bugs
= Scope plot line width shows current value at all times and not only when being focused by the user.
= Gplant for the position controller in the Frequency Response now includes the current controller.

Triamec.Tam.Core 19.0.0

Change
= Last-modified timestamps in the created report match those of the files on the drive.

Bug
= Fixes a regression as of 18.1.0 where one could no longer add the axis module to any instance of a
drive when seen via several adapters.

TAM Software 7.28.1

Plot derivatives.

Release date: 26.2.2025

Triamec.Tam.U! 8.3.0

New
= Adds a df/dt button to the plot tool bar and a respective entry to the scope menu, to plot the deriv-
atives of selected plots.

Bug
= Addresses an inconvenience when tuning frequency responses where the advanced notch filter co-
efficients were reset after temporarily turning the filter off.

= Fixes a defect in the FFA estimator where German customers saw numbers deviating by a decimal
factor from the expected estimate.

Triamec.Tam.Core 18.3.1

Bug
= Fixes a defect where the axis names weren't updated after loading a TAM configuration.
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TAM Software 7.27.0

Calculate initial gains and feed forward amplitude for the controllers in frequency response tuning.

Release date: 4.11.2024

Triamec.Tam.UI 8.2.0
New
= Frequency response tuning:
* Bode plot now includes the plant.
+ Adds buttons to calculate initial gains and feed forward amplitude for the controllers.
Bug
= Avoids a crash upon the attempt of loading TaMdmp files from different events aligned to trigger.
= Fixes parsing issues in the Axis Compensation Wizard.
= Fixes an issue where bit field members weren't available in F3 search.
= Fixes an issue where switching tabs when using the F3 search did not work.
= Fixes a focus issue where the F3 search remained as top layer.
= Correction of the Y-axis labeling in Bode-Plot.

= Fixes an issue where the modification asterisks was not removed upon manual revert in collapsed
tree

Triamec.Tam.Core 18.2.0

New
= TAM configuration extension for saving and loading informational registers. This allows to show the
correct drive information in simulated mode.

Bug
= Fixes a regression as of 18.1.0 causing updates of some older firmware to be much slower than ca-
pable. When hitting this issue, you saw a respective warning about the transfer slowness.

TAM Software 7.26.1
Hot fix for a deployment issue as of 7.26.0 on some Beckhoff IPCs with Windows Enterprise 2016 LTSB.

TAM Software 7.26.0
Use the Axis Compensation Wizard to set up or change your axis compensation with ease.
Open . TAMsnap device snapshot files for offline analysis.

Release date: 27.6.2024

New
= Assistant > Axis Compensation Wizard. Open the Axis Compensation Wizard from within the TAM
System Explorer. The Axis Compensation Wizard can also be opened as Standalone Application by
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executing AxisCompensationWizard.exe
Refer to AN140 Axis Compensation drive based for further information

File Scope |Assistant | Help S Search topology (F3)..
() - ; = _ -

Axis: Axis 1 v Automatic conversion and setup of the axis compensation. Upload a .csv
file containing 1D, 2D or 3D compensation data here. A header line is

Compensation dimensionality: 1D v expected and used to determine the number of columns.
The (reference) positions have to be evenly spaced. Use either ', or ;" as
separator.

Dim1 Source: tam://mc/Triamec-616/Axes[0]/S

Dimz;source: Example file for selected dimension:

Dim3 Source:

Compensation Data:

Table: TamTbl on Drive (1D) b
Persistency: [] Make persistent
Write Compensation

Parameters already written

Activate Compensation

Deactivate Compensation

Triamec.Tam.U!l 8.1.0

New
= File > Open Offline > Device Snapshot. Open a .TAMsnap device snapshot in a new instance of the
application in order to analyze the state of the device in one point in time.

= |ntroduces application wide keyboard shortcut F7 to let all devices record a dump.

Bugs
= Fixes a regression as of 8.0.0 where the Closed Loop Current Controller Test and Closed Loop Posi-
tion Controller Test methods could no longer be used in Frequency Response Measurement.

= Fixes a regression as of 7.20.1 where setup protection changes weren't immediately reflected in the
user interface.

= Fixes a regression as of 7.17.0 where it needed two clicks to stop a triggered scope.
= Fixes a crash when changing between two register views.
= Fixes a defect where a changed axis message didn't show up in the status bar.

® Fixes a defect where plots having recently been added from a scope template would be related to
the wrong axis after device enumeration.
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TAM Software 7.25.0

Places address field at the top and offers search functionality. Updates firmware faster.

Release date: 22.12.2023

Triamec.Tam.UI 8.0.0

New

= The address input field moved to the top and now features auto completion. Pressing F3 always
sets the focus to this field.

Sample_Config_Linear-Axis_400nm-Pitch - TAM System Explorer

=
= PC-CHM
El Simulation
=& NETCIR
=N Sample Station
=5 Ei Device
& Register
" Tama M

File Scope Help L sensorless

< tam://mc/Sample Station/Axes[0]/Parameters/CurrentController/SensorlessTransitionSt
<& tam://mc/Sample Station/Axes[0]/Parameters/CurrentController/SensorlessTransitionE
<& tam://mc/Sample Station/Axes[0]/Parameters/CurrentController/SensorlessBandpassD
& tam://mc/Sample Station/Axes[0]/Signals/CurrentController/Sensorless/

<& tam://mc/Sample Station/Axes[1]/Parameters/CurrentController/SensorlessTransitionSt
<& tam://mc/Sample Station/Axes[1]/Parameters/CurrentController/SensorlessTransitionE
<& tam://mc/Sample Station/Axes[1]/Parameters/CurrentController/SensorlessBandpassD
& tamy//mc/Sample Station/Axes[1]/Signals/CurrentController/Sensorless/

@ tamy//mc/Sample Station/Axes[0]/Signals/CurrentController/Sensorless/CurrentAlpha
< tam://mc/Sample Station/Axes[0]/Signals/CurrentController/Sensorless/CurrentBeta
& tamy//mc/Sample Station/Axes[0]/Signals/CurrentController/Sensorless/VoltAlpha

< tam://mc/Sample Station/Axes[0]/Signals/CurrentController/Sensorless/VoltBeta

<& tam://mc/Sample Station/Axes[0]/Signals/CurrentController/Sensorless/InductionAlph

<@ ‘tam:f/mc/Samp\e Station/Axes[0]/Signals/CurrentController/Sensorless/InductionBeta

< tamy//mc/Sample Station/Axes[0]/Signals/CurrentController/Sensorless/Angle

& tamy//mc/Sample Station/Axes[0]/Signals/CurrentController/Sensorless/AngleError
< tam://mc/Sample Station/Axes[0]/Signals/CurrentController/Sensorless/CntLast
& tamy//mc/Sample Station/Axes[0]/Signals/CurrentController/Sensorless/CntDiff

~

Angle [rad]
electrical angle from model

<& tam://mc/Sample Station/Axes[0]/Signals/CurrentController/Sensorless/InductionAlph

The entries feature a tool tip with unit and description.
= |n the register grid, allows to enter references to registers as an address, with the help of auto com-

pletion.

Change

= Copies only the value of the selected register to clipboard, and not longer the whole row.

Bug

= Fixes a regression in 7.20.1 where no cursor and analysis values were shown in loaded csv data
when the plots couldn't be related to registers.

Triamec.Tam.Core 18.0.0

Change

® |In conjunction with firmware 4.20 or newer, performs faster firmware updates.

Bugs

= Doesn't longer freeze when multiple drives are reconnected simultaneously via network.
= Fixes a regression in 17.0.2 where virtual COM devices wouldn't longer be automatically detected.
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TAM Software 7.24.1

Required for new firmware features.

Release date: 2.11.2023

Triamec.Tam.Ul 17.20.1
Bugs
= Scope correctly plots registers where the type can be flexibly chosen among float, hex and signed
integer.
= Fixes a defect where digital plots are outside the visible range when adding them after arranging a
scope with all non-digital plots.
= Fixes a defect where an FFT of a short period of data failed with error "Timestamp must be fully
specified".
= Gets plot highlighting right when scrolling the plot list and across sessions.
= Brakes a possible endless loop during Bode Measurement as of 7.19.0.
= Addresses an inconsistency in Dual Loop Bode Tuning when altering the feed forward acceleration.

Triamec.Tam.Core 17.0.2

Bugs
= Addresses timeouts during firmware download over Tria-Link bus as of firmware 4.18.
= Allows to open a TAM configuration offline which configures periphery.
= Fixes a defect as of 15.0.0 where acquiring two times from the same 64-bit register ended up in the
first variable carrying nonsensical data.
= Addresses a massive startup delay on some systems when Bluetooth was enabled.

TAM Software 7.24.0

Fixes some bugs and introduces a new scope template.

Release date: 4.7.2023

Triamec.Tam.U!l 17.20.0

Feature
® Introduces Sensorless Motor-R Analysis scope template.

Bug
= Backports Bode auto range behavior for firmware < 4.19 which had a defect which could cause the
scan to never terminate.

Triamec.Tam.Core 17.0.1

Bug
= Fixes an infrequent ArgumentException crash in the network subsystem after the connection has
been restarted.
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TAM Software 7.23.0

Access homing from within the axis user interface.

Release date: 15.6.2023

Triamec.Tam.Ul 7.19.0
New
= Allow to home the axis from within the axis user interface. If homing is configured, the homing state
is shown above the axis state.
= |n offline mode, prepend the window title with the name of the TAM configuration file the simula-
tion is based upon.
Changes
= Various changes and improvements in Bode measurement. These are the most important ones:

* Introduces an optimized frequency spacing which shortens measuring time while maintaining
quality. This is used as the default, but linear and logarithmic spacing can still be chosen.
Improved gain adaption in order to minimize discontinuities in the Bode graph.

Allows to input measurement point maxima with arbitrary precision.

¢ F12 now works within Bode.

[BREAKING] The .csv format has changed and cannot be interpreted with previous releases.
= Popular zoom arrange is propagated to the scope tool bar and mapped to the F6 key.

*

*

*

Discontinued
= Removes the Couple button from the axis module. Set the axis’ Commands/PathPlanner/Command

register to MoveDirectCoupled, instead.
Bugs
= Fixes a regression with 7.18.0 regarding narrow column widths in the register grid view when com-
ing from another tab.
= Fixes zooming issues in the Bode Tuning:
* In Bode graph, automatic zooming stops to work after comparison.
+ Nyquist zoom cannot be reset after repeated switching to Bode graph.
= Fixes an inconvenience where the time bar of plot CSV data reflected the elapsed time since mid-
night instead of the start of the measurement.
= Fixes a defect where the reference time shown on the upper right corner of the scope and when
printed had an offset when the scope rolled.
= Addresses crashes in the scope when data contains NaN or Infinity.
= Addresses installations where links cannot be opened automatically in the default browser.

Triamec.Tam.Core 17.0.0

Change
= DNS names of devices accessed via Ethernet are no longer resolved per default, since this led to

painful startup delays with some configurations. If necessary, check the new Startup > Use DNS
preference.
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TAM Software 7.22.2

Fixes bugs.

Release date: 21.2.2023

Triamec.Tam.Ul 7.18.2

Change
= Allows to disable the digital plot feature in the preferences (Appearance > Disable digital plot). This
may help to use vertical space more economically with many boolean valued plots involved.

Discontinued
= Removes the Coupling Manager from the axis module. Use the drive-to-drive data exchange feature
instead, described in application note AN142.

Bug
= Fixes a regression with 7.18.0 regarding enumeration register choice in the register grid.

TAM Software 7.22.1

Fixes bugs.

Release date: 2.2.2023

Triamec.Tam.Ul 7.18.1

Change
® Proposes the maximum possible value for the upper frequency bound in Bode measurement.
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TAM Software 7.22.0

Allows to protect setup.

Release date: 1.2.2023

New
= System suppliers can protect setup modifications through the TAM System Explorer with a password
using the menu File > Protect Setup. As an end user, you may see a lock symbol @ in various places
of the application where functionality is disabled.

Triamec.Tam.Ul 7.18.0

Change
= Register grid columns automatically grow to the required width. In turn, you can no longer resize
the width by yourself.

Bugs
= Fixes a regression as of 7.17.0 where non-boolean signals added to an arranged scope with only
boolean signals don’t receive their expected Y-axis.
= Fixes a regression as of 7.17.0 where Bode Tuning of filters in Dual-Loop mode was no longer possi-
ble.

Triamec.Tam.Core 16.0.0

Bugs
= Fixes a defect as of TAM Software 7.20.0 where devices were mirrored on network interface cards
which were not operational.
= Fixes a regression as of 15.0.0 where you received a message "illegal register offset reported" at
startup for drives with firmware <= 4.13.0. Then, those drives couldn’t be accessed.
= Fixes a regression as of 15.0.0 where an unexpected exception occurred upon the attempt to ac-
quire high-speed data from similar registers of several devices.
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TAM Software 7.21.0

Introduces a start dialog and decomposed bit fields.

Release date: 22.11.2022

New
® |ntroduces a start dialog shown when the TAM System Explorer doesn’t find any device.
= Decomposes bit fields. The most prominent example is the DigitallnputBits register. Continue to use
the register as a whole, but on top of that, unfold the register to show the individual fields with
their name, value, and description.

"""" # Message =] General ¥ Registers ‘@ Module - Scope (%3] Log
"""" 2 Messageld DigitallnputBits
= D‘lgltallnputBl’c5 Register Value Unit Description
....... > In1
4 n2 In1 True First digital input
....... n
’ n3 In2 True Second digital input
....... n
. na In3 True Third digital input
....... n
’ S Ind False Fourth digital input
....... n
f 6 In5 False Fifth digital input
....... > In
\/ In6 True Sixth digital input
------- 2 Encoder0 ;
. Encoder0 | False Encoder input 0
------- » Encoder1 ;
. Encoder1 | False Encoder input 1
------- » Encoder2 ;
) Encoder?2 | True Encoder input 2
------- 2 Encoder3 ;
. . Encoder3 | False Encoder input 3
....... ¢ OpthﬂO - - : : :
> OptionT Option0 True Option module input 0, if applicable
....... - ion
f Opt' 5 Option1 | False Option module input 1, if applicable
....... - ion
f Opt' 3 Option2 True Option module input 2, if applicable
....... - ion
. o op Option3 True Option module input 3, if applicable
------- 2 ledStatus

Additionally, the textual representation of the register changes from a hexadecimal value to a com-
prehensible bit-wise format.

ey —

Triamec.Tam.Ul 7.17.0

New
= Stacked arrangement of boolean valued registers including labels.
= Bode Measurement for One Position Two Motors setup.

Changes
= Selecting a register in the grid doesn’t longer locate it in the explorer. Use the new button S above
the grid when needed.
= An enabled axis with a warning shows both the enabled state and the warning indicator in the Axis
Monitor and the Axis Module. Previously, they only showed the warning.

Bugs
= Chooses more sensible defaults for positional maxima in Bode measurement and displays small val-
ues correctly.
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= Fixes too frequent zooming resets in the Bode graph of Bode Tuning regressed in 7.15.0.
= Makes frequency label editing work in the Bode Tuning Nyquist graph.

Triamec.Tam.TrialLink 7.17.0, Triamec.Tam.EtherCat 7.17.0

Bug
= Fixes a regression as of 7.16.0 where multiple network connections would be established to a drive
at the same time in the same app, and under the same network interface card.

Triamec.Tam.Core 15.0.0

New

= Adds address and channel information to the Tria-Link Health Monitor.
Bugs

= Fixes a regression as of 14.0.0 blocking TL firmware update.

= Fixes an issue where a device hot-plugged via network triggered loading of startup configurations
twice.
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TAM Software 7.20.0
Usability improvements and bug fixes.

Release date: 26.8.2022

Change
= We have renamed the Open simulated context menu on TAM configurations in the file explorer to

Open offline.

Triamec.Tam.Ul 7.16.1

New

= Menu File > Open Configuration Offline... closes the current Triamec - TAM System Explorer

window and starts a new instance with an offline system, :
which is seeded with the TAM configuration you pick. This File

. . . A
works similar to and complements the Open offline context | New >
menu on TAM configurations in the file explorer. PY  Open Workspace...

C? Open Workspace Folder

Changes
= |dentify offline system by means of
¢ an extra adapter icon, the same as used for Menu File >
Open Configuration Offline, and
+ a dark status bar including a dedicated label on the right Open Configuration Offline...
corner.

Recent Workspaces »

Load TAM Configuration...
Save TAM Configuration...

i

= Bode diagram leaves scale intact in compare mode. - < System
—-&% NETCLR

® Fixes a defect in Bode diagram with measurements partitioned
into several frequency ranges, where the cursor wasn’t placed
at the correct frequency when placing the other cursor on the
plot of a different frequency range.
= Fixes some issues with the Nyquist graph:
+ Axis ratio was not maintained after editing a range.
¢ The desired range wasn’t always set.
¢ The graph shrunk during continuous window resizes.

=N ) Sample Station

Triamec.Tam.Trialink 7.16.0, Triamec.Tam.EtherCat 7.16.0

New
= The network interface now continuously scans for connected devices.
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TAM Software 7.19.0

New scope templates, bug fixes.

Release date: 8.6.2022

Triamec.Tam.Ul 7.16.0

Feature
= Introduces and adjusts Scope templates for ideal use with the Drive Setup Guide.
= Create Report saves a support e-mail shortcut beneath the report archive.

Changes

= Renames Angle Search scope template to Phasing Analysis and adds position error.

= Closes Bode Measurement, Bode Tuning, Manage Persistency and Periphery Access dialogs if the
device is disconnected.

= Let's time start at zero when exporting plots to CSV. Previously, there was an offset related to the
Tria-Link timestamp.

= When a firmware download cannot be accomplished since the target is not ready (for example due
to STO), this is now indicated right when the download dialog is shown, rather than after having
commanded the download to start.

Bugs
= Fixes a crash in the scope when a cursor was active and there were no longer any plots after loading
a configuration (including scope autoload).

= When the host lost connection to a device (surprise removal), open windows tied to that device will
automatically close, and no longer cause a crash in that situation.

Triamec.Tam.Trialink 7.15.0, Triamec.Tam.EtherCAT 7.15.0

Change
= Previous version of the TAM Software use a different Triamec Workspace setting to save which net-
work interface cards to leverage. Upgrading to this version will enable all network interface cards.

TAM Software 7.18.0

Usability improvements and bug fixes.

Release date: 29.3.2022

Installation

Change
= Side-by-side installations don't longer share documentation.
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Triamec.Tam.Ul 7.15.0
Changes
= Various improvements in Bode Tuning:
+ Allows tuning the feed forward acceleration right in the interface.
+ Doesn't longer provide velocity controller tuning per default. The new Enable velocity controller
preference can be used to activate it, though.
+ Lets the user confirm any attempt to close the window while parameters are modified.
+ Doesn't longer revert parameters using ESC key.
* Introduces an option to render the phase in the range [-360°, 0°].
+ The ability to edit the axis ranges by clicking on the end labels is no longer restricted to the
phase axis. To compensate, the extra input box to limit the frequency has been removed.
+ Addresses an inconvenience where the phase axis limits were constantly rounded during interac-
tive range changes. Rounding is now limited to initial rendering.

* Frequency can be entered right in its label: Frequency: 440‘
¢ Cursors follow mouse clicks.
+ Cursors are easier to drag and plots are less narrow with high DPI .
scaling. 504 —‘}—— 2

+ Synchronizes the Bode plot areas to always share the same width, '
even with high DPI scaling.
+ Addresses an inconvenience where the signal list is not always visible.
+ Makes some controls more discoverable.
= Reduces default sampling time in oscilloscope to 0.1 ms.
Bugs
= Ceases showing unrelated data in a triggered scope when no data was yet acquired and the stop
button was clicked.
= Improves behavior when attempting to plot data above the supported volume.
= Fixes a race condition while opening the Link Health Monitor, leading to a Nul1ReferenceExcep-

tion.

Triamec.Tam.Core 12.0.5

Bugs
= Addresses an inconvenience where loading a TAM configuration with EnDat encoders times out.
Repeating the operation worked around this issue.

= Fixes a defect blocking firmware update for drives having revision OA, 0B, OC or OD.
= Addresses an issue where the sequence of progress messages during a firmware update wasn't al-
ways maintained.

Triamec.Common 7.3.6

Change
= Tria-Link access via PCl adapter card is no longer configured per default.
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TAM Software 7.17.2

Addresses issues regarding Tria-Link PCl and PCl express adapters. This update is highly recommended
when using this hardware.

Release date: 30.12.2021

Triamec.Tam.Core 12.0.4

Bugs
= Fixes data logging performance for Tria-Link adapters not providing an interrupt. On systems suffer-
ing from this issue, plotting data was barely possible. Due to an unfortunate timing, some systems
only reproduced the issue when the Firefox web browser was running.
= Addresses a data acquisition issue when data couldn’t be consumed in real-time. For example, at-
tempting to plot 80 kSamples in one second via a TL100 PCl adapter only showed appropriately half
a second of data.

TAM Software 7.17.1

Improves usability.

Release date: 14.12.2021

Triamec.Tam.Ul 7.14.1

Bug
= The emergency keys (F12 and Pause) now work in the Bode Measurement and Bode Tuning win-
dows, too.
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TAM Software 7.17.0

Introduces new elements in the Axis Monitor.

Release date: 22.11.2021

Triamec.Tam.Ul 7.14.0
Features
= The Axis Monitor replicates detailed warning and errors as provided by the devices.
= Errors or warnings shown in the Axis Monitor are replicated one at a time in the status bar.

Changes
= The Acknowledge Errors button is enabled as soon as warnings or errors appear in the Axis Monitor
irrespective of their persistence.
® The Create Report button already part of the log tab toolbar strip is now also available in the status
bar, flashing upon appearance of errors.
Bugs
= Addresses an issue in the Axis Monitor where acknowledging cleared a hidden axis error.
= Supports measuring a Bode plot of both axes of a drive simultaneously. Note that you still might run
short of resources when doing this with a dual-loop system, or when attempting to sample with
100 kHz.
= Addresses an issue where the original drive parameters were not restored if disabling failed after a
Bode measurement.
= Gets rid of the error message Issue in _parametersDataGridView... by removing obsolete parame-
ters from the axis module.

Triamec.Tam.Core 12.0.2

Bugs
= Works around a fatal exception at first start-up: bad parameter or other APl misuse Failed to config-
ure managed assembly logging, observed since 12.0.0.
= Handles a race condition during network discovery, while a network interface card is removed.
= Addresses a 12.0.0 regression where firmware update via Tria-Link PCI failed for new generation
drives with firmware prior 4.9.1.

Triamec.Tam.Simulation 7.1.7

Bug
= Addresses a regression in 7.1.5 where simulated drives with register layout 19 refused motion.

Drivers

New
= Driver support for most current Windows systems where you previously got an error code 52. These
drivers are backward compatible with previous versions of the TAM Software.
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TAM Software 7.16.1

This release contains bug fixes.

Release date: 20.9.2021

Triamec.Tam.Ul 7.13.1

Changes
= The top-level topology node is hidden from the view.

Bugs
= Addressed a crash as of 7.13.0 when the plot list of the scope became unusable on an attempt to
remove an aggregate function column.

= Addressed an issue where Bode measurement didn’t consider register parameter changes made be-
tween opening the window and starting a measurement, or in between measurements.

Triamec.Tam.Core 12.0.0

Bug
= Addressed a crash upon an attempt to load a dump file with more than 8 signals.

Triamec.Tam.Trialink 7.14.1

Bug
= Addressed a regression as of 7.14.0 where previous generation drives could no longer be simulated.
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TAM Software 7.16.0

This release features handling of a new kind of data logging files, that is, dump files produced by recent
firmware.

This release also improves usability and fixes some notable issues.

Release date: 15.6.2021

Triamec.Tam.Ul 7.13.0

Features
= Allow loading . TAMdmp dump files produced by recent firmware into the scope.

= The archive created with Help > Create Report now includes device-side reports.

Show absolute local time of the time axis origin in the scope.

Show address in tool-tip when hovering over a plot legend row.
Plots of short-named registers get a default name including the register’s parent name.

Changes
= Configuration dialogs now close automatically when successful.

= Serial numbers are always shown when needing to resolve the stations of a TAM configuration.
Bugs
= Addressed a crash as of 7.11.1 when the scope width collapsed.
Addressed a regression as of 7.12.0 where the cursor’s At wasn’t longer shaded.
Addressed a crash when computing FFT and some plots are muted.
Don’t longer reset zoom when computing FFT.
Addressed an issue where not all of a group of plots with the same name were correctly configured.

Triamec.Tam.Core 11.4.0
Bugs
= Fixed a regression as of 11.3.3 breaking firmware download for first generation drives.

= Addressed an issue where the application stops being responsive for a long time after Ethernet dis-
connect. In particular, the timeout was proportional to the number of plots in the scope.
* Fixed a race condition between USB hot-plug and application tear-down.
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TAM Software 7.15.1
Fix two regressions from TAM Software 7.15.0.

Release date: 31.3.2021

Triamec.Tam.Ul 7.12.1

Bug
= Addressed a regression as of 7.12.0 where zoom was reset prior FFT.

Triamec.Tam.Core 11.3.4

Bug
= Addressed a regression as of 11.3.3 blocking firmware download for drives with option modules.
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TAM Software 7.15.0

This release supports file system tables, a new firmware feature introduced with firmware release
4.11.x.

The software was backported to .NET framework 4.6.2, which should help out some customers to run
the TAM System Explorer on some older Beckhoff IPCs running Windows Enterprise 2016.

There were quite some bug fixes stemming from the analysis of crashes reported with the telemetry
feature introduced with TAM SDK 7.14.1.

We decided to rename the installer from TAM SDK to TAM Software, since software development is
clearly not its main use case.

Release date: 25.3.2021

Triamec.Tam.Ul 7.12.0

Features
= Bode measurements for Gantry mode added.
= Closed loop Bode based on position error now allows measurement during constant motion.
= When changing the line color of the first plot of a y-axis, the y-axis adopts that color.

Change
= Removed sensorless mode Bode as closed loop Bode can be used instead.

Bug Fixes
= Addressed an inconvenience where plots could be sorted by their columns, unexpectedly.

= Addressed a crash in scope auto-load after having used the green cursor.
= Addressed a crash in STD(BW) calculation due to an unexpected imaginary part.

Triamec.Tam.Core 11.3.3

Change
= Tama assembly is always saved in-line with the TAM configuration. The original path is retained for
reference only.

Bug Fix
= Address a dead-lock upon device restart as of 10.3.0.

Triamec.Tam.Trialink 7.12.2, Triamec.Tam.EtherCAT 7.12.2

Bug Fix
= Addressed a crash when using bridge mode and the Tria-Link ring address was unassigned.

Triamec.Tam.Simulation 7.1.3

Bug Fix
= Address an issue as of 7.1.1 where the simulation wouldn't send data logging packets for RLID19 de-
vices.
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TAM SDK 7.14.1

This is the first version we deploy a component with the TAM System Explorer gathering anonymous us-
age and crash data. You will be asked for consent upon application start. If your system can reach the in-
ternet and you let telemetry be enabled, you can expect faster reaction to application crashes.

Release date: 15.12.2020

Triamec.Tam.Ul 7.11.1

Features
= Experimental anonymous telemetry and crash data using Visual Studio App Center.

Changes
= At is now shown on top of the scope when blue and green cursors are shown, instead of in analysis.

= Reduced automatisms in cursor analysis function choice to y for the blue, and y2 for the green cur-
sor, and only the first time the cursors are enabled.
= Batch update shows a warning when nothing was updated.

Triamec.Tam.Core 11.3.1

Change
= Implemented UDP hole punching in order to increase reliability of data logging and other data from
the device over a firewall.

Bug Fixes
= Addressed broken firmware update to TLO300, TLO400 and TLU1.
® Fixed a crash as of 11.3.0 occurring with batch firmware update in presence of Tria-Link PCl adap-
ters.

Triamec.Common 7.3.1

Change
= TAM Configurations are opened with XCopy deployed TAM System Explorer as applicable.
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TAM SDK 7.14.0

We introduce an STD(BW) — standard deviation in function of frequency — plot useful to analyze stand-
still noise. Refer to the newsletter for more information.

You can now open a TAM configuration (simulated or not) with the most current TAM System Explorer,
or with the version specified by the Triamec workspace. Use the topmost context menu entries of the
file for this sake.

Release date: 12.11.2020

Triamec.Tam.Ul 7.11.0
Features
= STD(BW) - standard deviation in function of frequency - plot useful to analyze standstill noise.
= Second cursor value y2 shown in plot analysis. Ay and At automatically added when second cursor
appears.
= The Axis Monitor shows a blinking worker icon while the control system is overridden.

Changes
= Less intrusive Bode when an axis is already enabled. Measuring during coupled motion isn't per-

mitted, though.

= The Tama status indicators have been updated from textual to iconic representations in the Axis
Monitor.

= Live view is now enabled by default in the register grid, and the pause button is only shown in ad-
vanced mode.

= Reworked various icons in the property pages and some in the scope.

Bug Fixes

= Addressed an inconvenience in the axis module where it was not possible to detach in presence of
device errors.

= Address an issue where the FFT plot of a measurement series didn't reuse original formatting cor-
rectly.

® |mprove error message upon unparsable Bode measurement files.

Triamec.Tam.Core 11.3.0

Change
= Establish side-by-side support of the Ethernet over Tria-Link subsystem with 1IS or other web
servers. This can be configured by means of the Ethernet over Tria-Link HTTP proxy port setting.

Bug fixes
= Addressed a dead-lock upon an attempt to identify a freshly disconnected drive over Ethernet.
= Addressed a long timeout when clicking on the device node in the presence of inaccessible network
drives.

Triamec.Tam.Trialink 7.11.0, Triamec.Tam.EtherCAT 7.11.0

Bug fixes
= Don't crash in front of misaligned data received over USB.

SWNET_TamSystemExplorerReleaseNotes-7.29.0_EP001 2025-07-22 23 /25


https://www.triamec.com/en/read-post/tam-system-explorer-standstill-noise-analysis.html
https://triamec.com/

D)

triamec

= Don't crash when scanning a surprise-removed NIC.
Triamec.Tam.Simulation 7.1.1

Change
= Address an inconvenience as of 7.1.0 where it got more difficult to install the TAM SDK offline.
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Previous Releases

A textual change log of previous releases is deployed with the documentation [2].

References

[1] “TAM API release notes”, SWNET_TamApiReleaseNotes-7.29.0_EP001.pdf, Triamec Motion AG,
2025

[2] “TAM System Explorer 7.13.1 release notes”,
SWNET_TamSystemExplorerReleaseNotes-7.13.1_EP001.txt, Triamec Motion AG, 2020
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